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1 Amagve Kapsam

Kamu SM tarafindan saglanan SSL sertifikasyon hizmeti kapsaminda SSL sertifikasinin liretilebilmesi icin kurum
tarafindan PKCS#10 formatinda sertifika istegi olusturulmasi gerekmektedir. Bu dokiiman, SSL sertifikasi
edinmek isteyen kurumlara istek dosyasi olusturma ve Uretilen sertifikalarin yliklenmesi hakkinda genel bilgi
vermek amaciyla hazirlanmistir. Dokiiman, genel bir rehber niteliginde olup sirekli degisen teknoloji sebebiyle
en dogru ve gincel bilgi kurumun sertifikayi yikleyecegi sunucu tedarikcisinden elde edilmelidir.

Kamu SM, bir elektronik sertifika hizmet saglayici olarak yalnizca SSL sertifikasi talep edilen alan adlarini
sertifikalandirmakla ytkimli olup, Grlinlere 6zgi problemden sorumlu degildir.

2 Tanimlar ve Kisaltmalar
PKCS#10 CSR (Certificate Signing Request): Sertifika istek Dosyasi

PKCS#12 (PFX) dosyasi: Giiven zincirindeki tim sertifikalar ile sertifika ve iliskili 6zel anahtari iceren PFX uzantili
dosyadir.

MMC: Microsoft Management Console
3 SSL Sertifika istegi Olusturma
SSL sertifikasinin Gretiminin tamamlanmasi ve sertifikanin sunucuda kullaniminin aktif hale getirilmesi amaciyla

oncelikle SSL sertifika istek dosyasinin olusturulmasi gerekmektedir. Sertifika istek dosyasinin Subject alaninda
bulunmasi zorunlu ve opsiyonel alanlar ile bulunmamasi gereken alanlar Tablo 1'de verilmistir.

Tablo 1: Sertifika istek Dosyasi Alanlari
* Common Name (CN) alani disindaki alanlarin tiimu biytk harfle yazilmalidir.
** PKCS#10 isteginde alanlar doldurulurken Turkge karakter kullaniimaz.

Kullanim

Subject Alani Acgiklamalar
Durumu

DNS’te basvuru sahibi kamu kurum veya kurulusu adina kayitli sunucu adi yazilmahdir.
OV SSL wildcard sertifikalarda bu alana “*.<alan adi>” yazilmalidir.

CN (CommonName) Zorunlu Orn: * testdomain.gov.tr

Bu alan “*.com” veya “*.com.tr” gibi ayirt edici olmayan adlar icermemelidir.

Bu alana IP adresi veya i¢ sunucu adi yazilmamalidir.

Basvuru sahibi kamu kurumu veya kurulusunun teskilat kanununda veya diger mevzuatta yer alan
O (Organization) Zorunlu actk unvani veya anlasilir sekilde kisaltilmig bigimi bulunmalidir. Bu alanda yazan bilgi, isbu formda
yer alan "Kurum Yasal Adi/Unvani" bilgisi ile birebir ayni olmalidir.

Basvuru sahibi kamu kurum veya kurulusunun bulundugu dlkenin I1SO 3166-1 Alpha-2

C (Count Zorunlu
( ") standardinda yer alan ulke kodu (TR) yer almalidir.

uiln

ST (State or Province) Zorunlu Bagvuru sahibi kamu kurum veya kurulusunun bulundugu bilgisi bulunur.

OU (Organizational Unit)

L (Locality)
emailAddress Kullanilmamalidir.
givenName
surName
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Uyari: Olusturulan istek dosyalarinda “Subject Alternative Name (SAN)” alani bulunmasi gerekli degildir.
Sertifikaya yazilacak ek alan adlari icin basvuru sirasinda belirtmis oldugunuz alan adlari kullanilacak olup istek
dosyasindaki SAN alani dikkate alinmayacaktir.

SSL sertifika istek dosyasinin olusturulmasi igcin oncelikle anahtar ¢iftinin olusturulmasi gerekmektedir.
Ardindan acik anahtar ve kurum bilgilerinin yer aldigi sertifika istek dosyasi olusturulmalidir. Sistemde
olusturulan anahtar cifti ve ylklemesi yapilan SSL sertifikasi uyusmazsa sistem diizglin ¢calismayacaktir.

SSL sertifikasi sunucuya tanitildiktan sonra anahtar ciftiyle birlikte SSL sertifikasinin yedeginin alinmasi (export)
ve glvenli bir ortamda saklanmasi 6nemle tavsiye edilir. Olasi bir kayip/c6kme durumunda SSL yedeginden
herhangi bir sunucuya yeniden yikleme yapilabilir (import). Anahtarlar olmaksizin, sadece SSL sertifikasinin
yedeklenmesinin hicbir fonksiyonu yoktur.

SSL sertifikalari igin anahtar cifti Gretimi sertifika talep eden kurum tarafindan gergeklestirildiginden, Kamu SM
anahtar ciftini kurtaramaz. Bu sebeple export isleminin 6nemi, kritik verilerin yedeginin alinmasiyla esdegerdir.

Wildcard SSL sertifikasi ayni alan adi altinda ¢alisan sinirsiz sayida alt alan adi ve sunucu igin kullanilabilen SSL
sertifikasidir. Ornegin *.testdomain.gov.tr seklinde alinan wildcard SSL sertifikasi; mail.testdomain.gov.tr,
portal.testdomain.gov.tr gibi istenilen sayida alt domain adi igin kullanilabilir. Bu nedenle farkli domain
adlarinin sunuculardan hizmet verebilmesini saglamak icin tek bir wildcard SSL sertifikasinin hepsine ayri ayri
yuklenmesi gerekir. Wildcard SSL sertifikasi sertifika istek dosyasinin olusturuldugu sunucuya ytklendikten
sonra bu sunucudan export ile alinarak bir PKCS#12 (PFX) dosyasi olusturulur, daha sonra bu dosya diger
sunuculara import edilir. Boylelikle diger sunuculara da ayni SSL sertifikasi (anahtarlariyla birlikte) yliklenmis
olur.

Belirtilen anahtar (Gretimi ve sertifika istek dosyasi olusturma islemlerinin farkli ortamlarda
gerceklestirilmesiyle ilgili genel bilgiler bolim alt basliklarinda yer almaktadir.
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3.1 OpensSSL ile SSL Sertifikasi islemleri

Acik kaynak kodlu, erisimi kolay ve Windows ortamlarinda da calisabilen OpenSSL, SSL yiklenecek olan
sunucuya kurulur. Komut satirindan programin kurulu oldugu dizine gidilir ve komutlar \openssl\bin dizini
altindan galistirilir.

OpenSSL calistirildiginda “Warning: can’t open config file: C:\Openssl\bin\openssl.cfg” hatasi alinmasi
durumunda config dosyasi yolu asagida verilen komut ile gosterilebilir:

set OPENSSL_CONF=c:\[OpenSSL Dizini]\bin\openssl.cfg

3.1.1 Anahtar Cifti ve CSR Olusturma

SSL sertifikasinin yiklenecegi sunucu (izerinde 2048 bit RSA anahtar ¢ifti ve sertifika istek dosyasi
olusturulmahdir. Bu islem icin asagida verilen komut calistirilir:

openssl req -out CSR.csr -new -newkey rsa:2048 -keyout privatekey.key

Bu komut ile olusturulan anahtar cifti ve sertifika istek dosyasi \openssl\bin dizini altina yazilir. Komut
¢ahstirildiginda anahtarin korunmasi igin bir sifre sorulacaktir. Bu sifre, gliclii olmali ve daha sonra kullanilacagi
icin unutulmamahdir.

Yukaridaki komut calistirildigl zaman sertifikayi talep eden kuruma ait bilgiler sorulacaktir. Bilgiler, Kamu SM
tarafindan kontrol edilerek sertifika igerisine yazilacagindan bu bilgilerin dogrulugu 6nemlidir. Kontrol sonucu
olumsuz olan CSR dosyalari sertifikalandirilmayacaktir. Bu bilgiler girilirken dikkat edilmesi gereken hususlar
Tablo 1'de belirtilmistir.

OpenSSL konfiglirasyonuna bagl olarak, sertifika istek dosyasinin Subject alaninda bulunabilecek tim
secenekler (Orn. E-mail adresi vb.) kullaniciya sorulabilmektedir. Kamu SM tarafindan Subject alani igerisinde
kullanimina izin verilmeyen alanlarin istek dosyasinda bulunmamasi icin OpenSSL tarafindan bu alanlar
soruldugunda “Enter” tusuna basilarak atlanabilir. Ayrica bos birakilmasi halinde OpenSSL tarafindan varsayilan

o n

olarak atanan degerlerin kullanilmamasi icin “.” nokta karakteri girilerek bu alanlar atlanabilir.

Sertifika istek dosyasi Subject alaninda bulunacak bilgiler anahtar ¢ifti ve CSR olusturma komutu ile birlikte
verilebilir. Bunun i¢in asagidaki komut kullanilabilir:

openssl req -out CSR.csr -new -newkey rsa:2048 -keyout privatekey.key
-subj "/C=TR/ST=ANKARA/0=KURUM ADI/CN=testdomain.gov.tr"

CSR dosyasi olusturulduktan sonra Subject alani igerisindeki bilgilerin kontrol edilebilmesi ve dosyanin
bozulmadiginin dogrulanmasi icin asagidaki komutun kullanimi tavsiye edilir:

openssl req -text -in CSR.csr -noout -verify
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3.1.2 SSL Sertifikasi ile PFX Dosyasi Olugturma

Bir onceki boliimde belirtilen adimlar uygulayarak olusturulan CSR dosyasinin Kamu SM’ye génderiminin
ardindan SSL sertifikasi Uretilerek talep eden tarafa iletilir. SSL sertifikasinin sunucuya/sunuculara
tasinmasi/yiklenebilmesi (import) icin sertifika ve iliskili 5zel anahtari iceren PFX dosyasina ihtiya¢ duyulabilir.

Asagida yer alan openssl komutu ile ihtiya¢ duyulan PFX dosyasi olusturulabilir:

openssl pkcsl2 -export -out certificate.pfx -inkey privatekey.key -in certificate.crt

certificate.pfx: Olusacak PFX dosyasi ad..
privatekey.key: Onceki béliimde olusturulan 6zel anahtar dosyasi adh.
certificate.crt: SSL sertifikasi dosya adi.

Komutun g¢alistirilmasinin ardindan daha 6nceden 6zel anahtar dosyasinin korunmasi igin belirlenen parolanin
girilmesi beklenmektedir. Ardindan PFX dosyasinin korunmasi igin iki kez parola girisi yapilir (Not: Belirlenen
parola PFX dosyasinin sunucuya ylklenmesi sirasinda isteneceginden unutulmamahdir). Bu komut ile
olusturulan PFX dosyasi \openssl\bin dizini altina kaydedilir.

3.2 Java Keytool ile SSL Sertifikasi islemleri

Java diliyle yazilmis web uygulamalarinin galismasi igin gerekli olan web sunucularda istemciile sunucu arasinda
glvenli bir iletisim saglamak icin Truststore ve Keystore dosyalari kullaniimaktadir. Keystore dosyasi Ozel
anahtari kullanarak sifreleme ve imzalama islemi yaparken, Truststore dosyasi genellikle dogrulama islemleri
icin kullanilir.

SSL sertifikasinin ylklenecegi sunucu lzerinde Java Runtime Environment (JRE) veya Java Development Kit
(JDK) kurulu olmalidir. CSR dosyasi olusturulmadan 6nce, CSR olusumunda kullaniimak (zere bir keystore
olusturulmalhdir. Keystore, anahtar ve sertifika yonetim programi olan Java Keytool ile olusturulur. Java Keytool
programi, kullanicilarin kendi anahtar ciftlerini ve sertifikalarini yénetmelerine olanak saglar.

Java Keystore’da tutulan her sertifika ilgili anahtar ciftiyle iliskilidir. Bu iliski benzersiz bir takma ad (alias) ile
saglanir.

Keystore ve Truststore olusumu 3 adimda gerceklestirilir:

1. Keystore ve anahtar gifti olusturulur.
2. Keystore kullanilarak CSR olusturulur ve Kamu SM’ye gonderilir.

Truststore dosyasi icerisine Kamu SM’den gelen SSL sertifikasi ile bu sertifikanin Gst makam sertifikalari
import edilir.
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3.2.1 Anahtar Cifti ve CSR Olusturma

Java keytool ile anahtarlar ve sertifikalar bir keystore (anahtar deposu) dosyasi icinde saklanir. Keystore
olustururken sertifika istek dosyasi Subject alani icerisinde yer alacak bilgiler belirtilmelidir. Bilgiler, Kamu SM
tarafindan kontrol edilerek sertifika icerisine yazilacagindan dogrulugu 6nemlidir. Kontrol sonucu olumsuz olan
CSR dosyalari sertifikalandiriilmayacaktir. Bu bilgiler girilirken dikkat edilmesi gereken hususlar Tablo 1'de
belirtilmistir.

Windows sistemlerde asagidaki keytool komutu Java bin dizininde calistirilir:

keytool -genkey -alias <takma_ad> -keyalg RSA -keysize 2048
-dname "C=TR,ST=ANKARA,0=KURUM ADI,CN=testdomain.gov.tr" -keystore <domain_adi>.jks

NOT: Bu komutta <takma_ad> yerine uygun bir takma ad yazilmalidir. RSA anahtar algoritmasidir. 2048
anahtar boyudur. <domain_adi> yerine SSL ile sertifikalandiriimak istenilen domain adi yazilabilir. Eger
wildcard SSLicin islem yapiliyorsa, dosya isimlendirmesinde “*”
basina karakteri koyulmamalidir. Esasen dosya adinin dnemi yoktur, sadece anlasilir olmasi i¢cin domain adi

dosya adi olarak kullaniimustir.

karakterine izin verilmediginden domain adinin

“uxn

NOT: jks=java key store.

Komut calistirildiginda, keystore igin sifre sorulacaktir, ardindan keystore olusacaktir. Bu 6rnekte keystore
dosyasi, 6zel olarak belirtilmedigi icin \<JAVAHOME>\bin dizini altinda olusturulmustur. CSR olusturulurken ve
Kamu SM’den gelen SSL sertifikasi sisteme yliklenirken ayni takma adin kullaniimasi gerekmektedir.

Asagidaki komut yardimiyla CSR olusturulur ve Kamu SM’ye gonderilir.

keytool -certreq -keyalg RSA -alias <takma_ad> -file <domain_adi>.csr -keystore <domain
_adi>.jks

3.2.2 SSL Sertifikasini Sunucuya Tanitma

Kamu SM’den gelen SSL sertifikasini import etmeden dnce Kamu SM kok ve alt kok sertifikalarini sisteme
tanitmak gerekir. Kok sertifikayl tanitmak icin:

keytool -import -alias root -file koksertifika.cer -keystore <domain_adi>.jks
Alt kok sertifikayl tanitmak icin:
keytool -import -alias intermediate -file altkoksertifika.cer -keystore <domain_adi>.jks

Kamu SM’den gelen sertifika dosyasi (.cer veya .crt uzantili bir dosya olacaktir.) Truststore dosyasi icerisine
asagidaki komut yardimiyla import edilir.

keytool -import -alias <takma_ad> -file <domain_adi>.cer -keystore <domain_adi>.jks
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3.3 MMC (Microsoft Management Console) ile SSL Sertifikasi Islemleri
Microsoft Management Console, Windows tabanli sistemlerde pek ¢ok islevin yerine getirilebilecegi yonetim
aracidir. Asagidaki bolimlerde MMC kullanarak SSL sertifikasi lretimi icin gereken istek dosyasinin
olusturulmasi ve Gretilen sertifika ile PFX olusturma islemlerine dair agiklamalar bulunmaktadir.
3.3.1 Istek Dosyasi (CSR) Olusturma
MMC kullanarak CSR olusturabilmek i¢in asagida yer alan adimlar sirasi ile takip edilmelidir:
1- Windows “Baslat” meniisiinden arama kismina “mmc” yazilarak “Enter” tusuna basilir.
2- Agilan pencerede “File” kismindan “Add/Remove Snap-in” yazisina tiklanir.
& Consolel - [Console Root] - o *
& Fle Action View Favourites Window Help x
& New CtieN
Open. Ctis0 Mame —
::Mm o There are na items to shaw in this view. Censole Root a
S g
Options...
3- Gelen sayfada “Certificates” secilir ve “Add” butonuna tiklanarak ilgili ekleme islemi yapilir. Ardindan
“OK” butonu ile adim tamamlanir.
F& Console’ - [Console Root]
& File Action View Favourites Window Help
e = H
| Console Root Name
There are no items to show in this view.
Add or Remove Snap-ins X
You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.
Available snap-ns: Selected snap-ins:
Snap-n vendor ~ [ console Root Edit Extensions...
+ | Activex Control Microsoft Cor. Gl Certficates - Current User
ithorization Manager Microsoft Cor... femes
. icates Microsoft Cor...
j": Companent Services Microsoft Cor... Move Up
e e ||
= Disk Management Microsoftand. .
event viewer Mierosaft Cor.
[ZFolder Microsoft Cor...
|=] Group Policy Object ... Microsoft Cor...
B, 1P Security Monitor  Miroseft Cor...
&, P security Policy M...  Microsoft Cor.
%,LinkaEhAdfizEss !-/!\unsufitcrnr.” w Advanced...
Description:
The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.
Concel
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4- Sonraki adimda sol meniide “Console Root” altinda goziikecek “Certificates” kismina cift tiklayarak
sertifika klasorlerinin goziikmesi saglanir. “Personal” yazan klasor (izerine sag tiklanarak agilan
meniden sirasi ile “All Tasks > Advanced Options > Create Custom Request” secilerek istek olusturma
adimina gegilir.

Consalel - [Cansole Roof\Certificates - Current User\Personal] - o x
@ File Action View Favourites Window Help - & x
es | nm o6z HmE

(=] Consele Root
v 3l Certificates - Current User

» . Person N
o rusted | Find Cetfcates. |

Object Type Actions

There are no items to show in this view. Personal a

More Actions 3

» [ Enterpr All Tasks > Find Certificates...
> [ Intermy

S 7 Active View > Request New Certficate..

5 [0 Trusted  NewWindow from Here Import,

> [ Untrust -
5> [ Third-F New Taskpad View... Advanced Operations > Create Custom Request...

D Tusted  Refresh Enroll On Behalf OF...
» [ Client )

Export List...
> 1 Local K portHt
> [ Certific  Help
> [Z] Smart Carormosteewoor

Manage Enrellment Pelicies...

&:Create Custom Request.

5- Buadimda “Next” butonu tiklanarak sonraki sayfaya gegilir.

@ Consolel - [Console Root\ Certificates - Current User\Personal]
& File Action View Favourites Window Help
% n@ 86 HE

(| Console Root Object Type

v G Certificates - Current User
3 1 Personal There are no items to show in this view.

(1 Trusted Root Certification Authorities

(] Enterprise Trust

1 Intermediate Certification Authorities

[ Active Directory User Object

(1 Trusted Publishers

[ Untrusted Certificates Before You Begin

(1 Third-Party Root Certification Authorities

[ Trusted People The following steps will help you install certificates, which are digital credentials used to connect to wireless

1 Client Authentication Issuers networks, protect content, establish identity, and do other security-related tasks.

1 Local NonRemovable Certificates

1 Certificate Enrolment Requests

[ Smart Card Trusted Roots

5] Certificate Enroliment

Before requesting a certificate, verify the following:

Your computer is connected to the network
You have credentials that can be used to verify your right to obtain the certificate
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6- Burada yer alan “Proceed without enrollment policy” yazisi secilerek “Next” butonu ile sonraki adima

gegilir.

& Console1 - [Console Root\Certificates - Current User\Persanal]
& File Action View Favourites Window Help
L I (ETEE 7

[ Console Raot Object Type
~ [l Certificates - Current User

» || Personal

5 [ Trusted Root Certification Authorities

» [ Enterprise Trust

» [ Intermediate Certification Autherities

5 [ Active Directory User Object

5 [ Trusted Publishers

» [ Untrusted Certificates

» [ ] Third-Party Root Certification Authorities

5 [ Trusted People

» [ Client Authentication Issuers

» [ Local NenRemovable Certificates

5 [ Certificate Enrolment Requests

5 [ Smart Card Trusted Roots

There are no items to show in this view.

(5] Certificate Enrollment

Select Certificate Enrollment Policy

Certificate enrollment policy enables enrollment for certificates based on predefined certificate templates.
Certificate enrollment policy may already be configured for you.

Configured by your administrator
Active Directory Enrallment Policy v
Configured by you Add New

Custom Request

Proceed without enrollment policy

7- Bu sayfada yer alan “Template parametresinin “(No Template) CNG key”, “Request Format”

parametresinin ise “PKCS#10” olarak secildiginden emin olunmalidir. Ardindan “Next” butonu ile

sonraki adima gegilir.

] Console Root Object Type
~ [ Certificates - Current User
» | Personal
] Trusted Reet Certification Authorities
[ Enterprise Trust
] Intermediate Certification Authorities
(] Active Directary User Object
(] Trusted Publishers
] Untrusted Certificates
| Third-Party Root Certification Authorities
[ Trusted People
] Client Authentication Issuers
] Local NenRemovable Certificates
] Certificate Enrolment Requests
] Smart Card Trusted Roots

There are no items ta show in this view.

5] Certificate Enrollment

Custom request

Chose an option from the list below and canfigure the certificate options as required.

Template: (o template) NG key e

[ Suppress default extensions

Request format: (@) PKCS 10
[@]ele

Note: Key archival is not available for certificates based on a custom certificate request, even when this
option is specified in the certificate template.

e
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8- Burada yer alan “Properties” kismina tiklanarak CSR bilgilerinin olusturulacagi yeni bir panel agilir.

R Console? - [Console Root\Certificates - Current User\Persenal]
& File Action View Favourites Window Help
e nFEEld= BE

|| Console Root Object Type
~ Gl Certificates - Current User
s [EiPeeana There are no items to show in this view.
> ] Trusted Root Certification Authorities
5 ] Enterprise Trust
5 1 Intermediate Certification Authorities - (] x
; g ﬁ:;‘t’:fp"j;‘::’e ’u:e’ Object 5] Certificate Enrollment
» [ Untrusted Certificates
> ] Third-Party Reot Certification Autherities Certificate Information
5 7 Trusted People
> [ Client Authentication Issuers Click Next to use the options already selected for this template, or click Details to customize the certificate
5 ] Local NonRemovable Certificates request, and then click Next,
» [ Certificate Enrelment Requests
> [ Smart Card Trusted Roots Custom request 1) STATUS: Availzble Details ~
The following options describe the uses and validity period that apply to this type of certificate:
Key usage:

Application policies:
Validity period (days):

9- lgili panelde yer alan “General > Friendly name” kismina alan adiniz veya belirlediginiz bir ad

girilebilir.

File Action View Help
e AmodzEmE
W Certificates - Current User Issusd To Issusd By Expiration Date  Intended Purposes  Friendly Nama Status  Certificate Tem..
~ ] Personal
1 Contificates There are no items ta showin this view.
tusted Roat Centification Aut
nerprise Trust
Intesmediate Centification Aut
fetive Directory User Objeet
usted Publishers
Intrusted Certificates
hire-Party Ract Cartification
rusesd Pecgle 5 Certifiate Enraliment
Client Authentication Issuers
ther People
! Local NonRemavable Certificy Certificate Information Certificate Properties *®
| WslEHistaryJoumal
5 Cerficate Envolment Request Click Next to use the options already G018l Subject  Evensions  Private Key.
| Smart Card Trusted Roots request, and then dick Next,

Afriendly name and descriptin will make it easier to identify and use a certificate.

Eriendly name:

Custom request

Tha following options describg | 'E5100meingowtr
Key usage: Description:
Application policies:

testdomaingowty
Validity period (days):

3 Cancel Eosly
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10- Yine ilgili panelde yer alan “Subject > Subject Name” kisminda bulunan sertifika Subject alaninda yer
alacak alanlar segilerek “Value” kismina deger yazildiktan sonra “Add” butonu ile eklemeler yapilir. Bu
bilgiler  girilirken  dikkat  edilmesi  gereken hususlar  Tablo  1'de belirtilmistir.

-]

[@ File Adion \View Favourites Window Help

% 2m 0/ dz B

| Cansole Raot

w Ly Centificates - Current User
| personal
1 Trusted Root Certification Au
] Enterprise Trust
7| Intermediste Cortfication Au
] Active Directory User Ghbject L] Certificate Enrollment
3 Trusted Publishers
1 Untrusted Certificates

Third-Party Root Certification Cetificate Information

Objoct Type
Certificates

| Trusted People
- Client Authentication Issuers Click Next to use the options already selected for this template, o click Details to customize the certificate
] Lacal NonRemovable Certifi request, and then click Next

1 MSiEHistoryJournal
1 Certificate Enrolment Reques Custom request

i) STATUS: Available Details * |
Smart Card Trusted Roots

The following options descibe| ¢qiicate Properties

Application pelicies:

General Subject Extensions  Private Key
Validity period (doys)

The subject of a certificate is the user or computer to which the certificate is issued. You
can enter informatian about the types of subject name and altemative name values that
can be used in a certificate.

Subject of certificate

The user or computer that is recaiving the certificate

Subject name:

T gav.
I O=KURUM ADI
Country 5=ANKARA
Value: C-TR

Remove
Alterative name:
Type:
Directory name
Valuer
Add >
Remove

« > :lm e oy

Personal store contains 1 certificate.

11- Subject bilgileri girildikten sonra “Private Key” tabinda “Key Options” kismindan “Key Size > 2048”,
“Select Hash Algorithm” kismindan ise “sha256” 6zet algoritmasi segilir. Ayni zamanda “Make private
key exportable” secenegi de isaretli olmalidir. Aksi halde, liretilen sertifika ile PFX olusturma adimi

basarisiz sonuglanacaktir. ilgili ayarlamalar yapildiktan sonra “Apply” ardindan “OK” butonuna
tiklanarak son asama olan CSR kayit asamasina gegilir.

R Console! - [Console Root\Certificates - Current User\Personal]
[@ File Action View Favourites Window Help
e @ o d: BE
[ Console Root Object Type
~ [l Certificates - Current User
s [Elpeemal There are no items to show in this view.
> [ Trusted Root Certification Authorities
> [ Enterprise Trust
> 1 Intermediate Certification Autherities - o X
> [ Active Directory User Object
3 =] Trusted Publishers (5 Certificate Enrollment
5 [ Untrusted Certificates Catficate Properties »
5 [ Third-Party Root Certification Authorities Certificate Information
> [ Trusted People General Subject Extensions Private Key
> [ Client Authentication Issuers Click Next to use the aptions already sel
5 [ Local NonRemovable Certificates request, and then click Next. Cryptographic Service Provider v
> [ Certificate Enrolment Requests
> (] Smart Card Trusted Roots Custom request P "
ey options ~
The following options describethe | set the key length and export options for the private key.
Key usage: )
Application policies: Key size: 2048 -
adivpecdlic=iy Make private key exportable
[ Allow private key to be archived
[ 5trong private key protection
Select Hash Algorithm ~
Select Hash Algorithm to be used for this request
Hash Algerithm: | gha256 -
Select Signature Format v
[ ok || cancel || apny
Personal store contains no certificates.
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12- Son adimda “File Format” Base 64 olarak segilip CSR’nin kaydedilecegi dosya yolu girilerek islem
tamamlanir.

ﬁ Consolel - [Console Root\Certificates - Current User\Personal]
[& File Action View Favourites Window Help
e | nmol6= HE
(] Console Root Object Type
v [ Certificates - Current User
s [ Personal There are no items o show in this view.
> [ Trusted Root Certification Authorities
> [ Enterprise Trust
> [ Intermediate Certification Authorities - [m} x
5 [ Active Directory User Object
> [ Trusted Publishers
5 [T Untrusted Certificates
» [] Third-Party Root Certification Autherities

5] Certificate Enroliment

Where do you want to save the offline request?
5 [ Trusted People

> [ Client Authentication Issuers If you want to save a copy of your certificate request or want to process the request later, save the request
» [ Local NonRemovable Certificates to your hard disk or removable media. Enter the location and name of your certificate request, and then

» [ Certificate Enrolment Requests click Finish

5 [ Smart Card Trusted Roots

File Names
cvser e

File format:
@® Base 64
O Binary

Finish Cancel

Personal store contains no certificates,

3.3.2 SSL Sertifikasi ile PFX Dosyasi Olusturma

Bir onceki bolimde belirtilen adimlar uygulayarak olusturulan CSR dosyasinin Kamu SM’ye génderiminin
ardindan SSL sertifikasi Uretilerek talep eden tarafa iletilir. SSL sertifikasinin CSR dosyasinin olusturuldugu
sunucudan baska bir sunucuya tasinmasi/ytklenmesi (import) gibi sebeplerle PFX dosyasina ihtiya¢ duyulabilir.
PFX dosyasinin olusturulabilmesi icin SSL sertifikasi ve iliskili 6zel anahtarin ayni bilgisayarda olmasi gerekir.
Asagida yer alan adimlar sirasi ile takip edilerek PFX dosyasi olusturulabilir:

1- Windows “Baslat” menisiinden arama kismina “mmc” yazilarak “Enter” tusuna basilir.

2- Acilan pencerede “File” kismindan “Add/Remove Snap-in” yazisina tiklanir.

3- Gelen sayfada “Certificates” secilir ve “Add” butonuna tiklanarak ilgili ekleme islemi yapilir. Ardindan
“OK” butonu ile adim tamamlanir.
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4- Sonrasinda acilan sayfada “Personal” kisminda yer alan “Certificates” Gizerine sag tiklanarak “All Tasks
> Import” yazisina tiklanir.

ﬁmﬂmqr [Certificates - Current Ussr\Personal\Certificates]
File Action View Help
% 75 0O & HBE

G Certificates - Current User

Issued To Issued By Expiration Date  Intended Purposes  Friendly Name Status  Certificate Tem...

v [ Persanal

T Certific;2=- There are o items to show in this visw.
o ) Trusted Ro | All Tasks. > Request New Certificate..
» [ Enterprise e | Import..
> [ intermediz
> [ AdiveDire  Refresh AT
> B TustedPu pportList.
» [ Untrusted
> [ Third-Party Help
> ] Trusted People
» [ dlient Authentication lssuers
> [ Other People

> [ Local NonRemavable Certifice

» [ MslEHistoryJournal

v [ Certificate Enralment Reguesi|
[ Certificates

» (1 Smart Card Trusted Roots

« 0

|Add a certificate to a store

5- Aclilan ekranda “Next” butonuna tiklanarak uretilen sertifikayl segmek icin “Browse” butonuna tiklanir.
Sertifika secimi yapildiktan sonra tekrar “Next” butonuna tiklanir.

JB certmor - (Certificates - Current User\Persanah(

File Adion View Help
e 2@ 0 o BE

50 Certificates - Current User Issued To
~ [ personal
[ Certificates
» (2] Trusted Root Certification Aut
2 Enterprise Trust
Intermediate Certification Aut|
© Active Directory User Object X
% Trusted Publishers
2 Untrusted Certiicates & Certifieste Import Wizard
* Third-Party Root Certification
sted Peaple

Issuad By Expiration Date  Intended Purposes  Friendly Name Status  Certificate Tem.

There are na items to show in this view,

Client Authentication Issuers

- Other Peopl File ta | ot
(2] Other Pecple e

. Spechy the fle you want to import.
> [ Local NonRemovable Certificz b "
5> | MSIEHistoryleurnal

~ [ Certificate Enralment Request]

1 Certificates Bie nome: B
> [ Smart Card Trusted Roots ‘c\users_smnmmnm ‘ o

Note: More than one cartficate can be stored in a single il in the folowing formas:
Personal Information Exchange- PKCS #12 (PFX, P12)
Cryptographic Message Syniax Standard- PKCS #7 Certiicates ( P7B)
Microsoft Serialised Gertficate Store (.SST)
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6- Sonraki adimda gelen ekranda herhangi bir degisiklik yapilmadan “Next” butonu ile devam edilir.

File Adion View Help

= 217 0/d BE

() Certificates - Current User Issued To
- Personal
" Certificates

» [ Trusted Root Certification Aut

> [ Enterprise Trust

> 1] Intermediate Certification Aut

[] Active Directory User Object

» [ Trusted Publishers

> [ Untrusted Certificates

» [ Third-Party Root Certification,

> [ Trusted People

» [2] Client Authentication Issuers

> [l Other People

> 7] Local NonRemovable Certifice

> [ MslEHistorylournal

v [ Centificate Enrolment Request
[ Certificates

» 2] Smart Card Trusted Roots

< >

Issued By Expiration Date  Intended Purposes  Friendly Name Status  Certificate Tem..

There are na items to show in this view.

& k* Centificate Import Wizard

Certificate Store

areas. kept.

, o you can for
the certficate.

) Automatically select the certficate store based on the type of certficate

@ place all certficates in the folowing store

Certfieate swore:
persenal Bronse...

Next Cancel

Personal stare contains no centificates.

7- Ardindan gelen ekranda “Finish” butonuna tiklanarak adim tamamlanir. Burada sertifikanin basaril
sekilde import edildigine dair uyari mesaji gosterilir. “OK” butonuna basilarak mesaj kapatilir.

File Action View Help

% 20 0 c HE

P Certificates - Current User Issued To
~ [ Personal
_ Certificates

> [ Trusted Root Certification Aut
» [ Enterprise Trust
> [ Intermediate Certification Aut
> [ Active Directory User Object
» [ Trusted Publishers
» |2 Untrusted Certificates
» ] Third-Party Root Certification
» [ Trusted People
» [ Client Authentication Issuers
» [ Other People
» [ Local NanRemovable Certifice
» [ MsiEHistaryJournal
~ [ Certificate Enrolment Request

[ Certficates
> () Smart Card Trusted Roots

Issued By Expiration Date  Intended Purposes  Friendly Name Status  Certificate Tem..

There are no items to shaw in this view:.

k¢ Centificate Import Wizard

Completing the Certificate Import Wizard

‘The certificate will be imported after you click Finish.

You have specified the fallowing setiings:

elected by User ECSIEY
Confste
Ciser- I o 501
. 5

Finish Cancel
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8- Sertifikanin basarili sekilde import edilmesinin ardindan sertifika ve anahtar ciftini iceren PFX
dosyasinin disariya alinmasi (export) gerekmektedir. Bunun icin sag bolimdeki sertifika isminin Gizerine
sag tiklanarak “All Tasks > Export” butonuna tiklanmalidir.

& certmar - [Certificates - Current User\Personah Certificates] - a %
File Adion View Help

e N 4L XEO HmE

: - ssued To tssu spiration Date  Intended Purposes  Friendly Name: tatus  Certificate Tem..
() Certificates - Current User Issued T ed By Expi Dat ded Pu Friendly N: E Certificate Te
v 1 personal SECTYITTY ==
© ! crer Auth
! Certificates Open
> [ Trusted Roat Certification Aut
[ Enterprise Trust Al Tasks > Open
> [ Intermediate Certificaticn Aut
- rermedaeceriication cut Request Certificate vith New Key..
| Active Directory User Object
» 7 Trusted Publishers Copy Renew Certificate with New Key..
> ) Untrusted Certificates (e Advanced Operations
J Third-Party Root Certification =
> [ Trusted People EEShe Export..
5 [ Client Authentication Issuers. Help T
| Other People
> [ Local NonRemovable Certificz

> () MsieHistorylournal

~ [ Certificate Enrolment Reguest|
! Certificates

> [ Smart Card Trusted Roots

9- Aclilan ekranda “Next” butonuyla ilerlenerek sonraki adima gegcilir. Burada yer alan “Yes, export the
private key” secenegi isaretlenmelidir. Ardindan “Next” butonu ile devam edilir.

I8 certmar - [Cortficates - Cument UseriPersonal\Cerificates —
Fle Acion View Help
w2 4 XE HE

= Certificates - Current User Issued To Issued By Expiration Date  Intended Purposes  Friendly Name Status  Certificate Tem._
~ I Personal Bl testdomaingoutr TUBITAK Kamu SM SSL Sertifika Hiz.  28/11/2023 Server Authenticatio_  myesr

] Centificates

1 Trusted Root Certification Aut

5 [ Enterprise Trust

Intermediate Certification Aut
> [ Active Directory User Object X

Trusted Publishers
> [ Untrusted Certificates € & Certificate Export Wizard

Third-Party Root Certification
> [ Trusted People

Client Authentication Issuers
> [ Other People

Local NonRemovable Certifice
> [ MSIEHistoryJournal
~ (] Certficate Enrolment Request

B Certificates Private heys are password protected. If you want 1 export the private key with the
certiicate, you must type 2 password on 3 later page.

Export Private Key
You ean choose tb exportthe private key with the certficate.

> [ Smart Card Trusted Roots

you

® Yes, exportthe private key

[ Ney de not export the private key
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10- Sonraki ekranda asagidaki gibi belirtilen segimler isaretlenmis ise herhangi bir degisiklik yapilmadan
“Next” butonu ile devam edilir.

Cy

File Adion View Help

er\Personal\Cer

e A L XE B

5 Certificates - Current User
~ 2] Personal
| Certificates
1 Trusted Root Certification Aut
%) Enterprise Trust
] Intermediate Certification Aut
] Active Directory User Object
) Trusted Publishers
) Untrusted Certificates
) Third-Party Root Certification|
1 Trusted People
~1 Client Authentication Issuers
%] Other People
1 Local NonRemovable Certific|
1 MSiEHistoryJournal
~ 1 Certificate Enrolment Request|
1 Certificates
> = Smart Card Trusted Roots

Issued To
i testdomaingovir

Issued By Expiration Date  Intended Purposes  Friendly Name Status  Certificate Tem..

TUBITAK Kamu SM SSL Sertifika Hiz..  28/11/2023 Server Authenticatio.. mycsr

« & Certificate Export Wizard

Bxport File Format
Certficates can be exported in a variety of fie formats.

Select the format you want to use:
DER encoded binary X.509 (.CER)
Base-64 encoded X.509 (.CER)
Cryptographic Message Syntax Standard - PKCS #7 Cartficates (.P78)
Include i certficates in the certfication path f possble
@ Personal Information Exchange - PKCS #12 (.PFX)
7 Inciude al certficates in the certiication path if possble
] Delete the private key i the export s successful
1 Export all extended properties
| Enabe certficate privacy

Microsoft Serialsed Certficate Store (.S5T)

11- Agilan ekranda “Password” secenegi isaretlenerek PFX dosyasi icin parola belirlenmelidir. Parola girisi
yapildiktan sonra “Next” butonu ile devam edilir (Not: Belirlenen parola PFX dosyasinin sunucuya
yuklenmesi sirasinda isteneceginden unutulmamalidir).

File Action View Help

e 2@ LEXE BE

¥ Certificates - Current User
v [ Personal
1 Certificates
) Trusted Root Certification Aut
2 Enterprise Trust
» [ Intermediate Certification Aut
71 Active Directory User Object
21 Trusted Publishers
21 Untrusted Certificates
> 1] Third-Party Root Certification
7| Trusted People
| Client Authentication Issuers
7| Other People
7 Local NonRemovable Certifice
2| MSlEHistoryJoumnal
v [ Centificate Enrolment Request
1 Centificates
> (2] Smart Card Trusted Roots

Issued To
B testdomaingovitr

Issued By Expiration Date  Intended Purposes  Friendly Name Status ~ Certificate Tem..

TUBITAK Kamu SM SSL Sertifika Hiz. 28/11/2023 Server Authenticatio.. myesr

© & Centificate Export Wizard

Security
To maintain securty, you must protect the private key to a security principal or by using
2 password.

Group or usernames (recommended)

Add
Remove
4 Password:
==
Confirm password:
Encrypton:  TripleDES-SHAL
Next Cancel
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12- Son olarak PFX dosyasinin kaydedilecegi dosya yolu secilerek “Next” butonu ile islem tamamlanir. PFX
dosyaniz belirttiginiz dosya yoluna kaydedilecektir.

[ c=rtmgr - (Certificates - Current Usen\PersonahCentficate 3
File Action View Help

e 2@ LB XE o]

@ Cfﬂl‘-faleS—erenlUw Issued To Issued By Expiration Date  Intended Purposes  Friendly Name Status  Certificate Tem...

v ~j"z:"rm B testdomaingovir TUBITAK Kamu SM SSL Sertifika Hiz..  28/11/2023 Server Authenticatio.. - mycsr

» | Trusted Root Certification Aut

» [ Enterprise Trust

» | Intermediate Certification Aut|

1 Active Directory User Object X

» L] Trusted Publishers

> [ Untrusted Certificates « & Certificate Export Wizard

» [ Third-Party Root Certification;

> [ Trusted People

> [ Client Authentication Issuers

» [ Other People nk‘;p;mﬂummnﬂﬂ!ﬁywwnmmmn

> [ Local NonRemovable Certifice]

» [ MSlEHistorylournal

v [ Certificate Enrolment Request||

7 Certificates. Ee name:
> ] Smart Card Trusted Roots testdomain.gov.v.pfx Browse...
Next Cancel
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